
Symbols, Images, and Objects 
A symbol is a group of lines and arcs that is treated as a single 
entity. Symbols in DataCAD can be organized and displayed in 
templates. With DataCAD’s Template menu, you can enter 
symbols in your drawing, revise symbol descriptions as well as 
the symbols themselves, and even create new symbols from 
geometry in your drawing. Each symbol can have an unlimited 
amount of information associated with it. And one of the 
biggest advantages to using symbols in your drawings, instead 
of separate lines and arcs, is that you can use this information 
to generate a variety of schedules and estimates. 

In addition to symbols, you can also import bitmap (.BMP) and 
JPEG (.JPG) images into your drawings or insert o2c objects. 
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Inserting Symbols in Your Drawing 
There are two methods for inserting symbols into your drawing. Using the Insert 
pull-down menu is faster, but using the Template menu offers you more options 
for working with your symbols. 

 To insert a symbol into your drawing using the Insert menu: 

1. Click on Symbol in the Insert pull-down menu. A dialog box is displayed, 
listing all symbol folders in your DATACAD\SYM folder. 

Shortcut: Press (“) (the double quotation key) to insert a symbol. 

2. Double-click on a symbol folder to open it and display those symbols. 

3. Click on the name of the symbol you want to use; if Show Preview is 
checked, a preview of the selected symbol is displayed in the preview 
window on the right side of the dialog box. The symbol preview displays 
in either orthographic (plan) or isometric view, depending on either the 
Symbol Preview setting on the Misc tab of the Program Preferences 
dialog box, available from the Tools pull-down menu, or the Isometric 
View checkbox in the Insert Symbol dialog box. 

4. Click on Open. The dialog box closes, and the Insert/Symbol menu is 
displayed in the Menu Window. Notice that a box representing the 
extents of the symbol is now attached to your cursor at the symbol’s 
insertion point. 

5. Change the symbol’s size if necessary. Before you place the symbol in 
your drawing, you can increase or decrease the size of an entity by 
entering specific enlargement values for the X, Y, and Z axes: 

• To resize the symbol while maintaining its original scale, increase the 
XEnlgmt, YEnlgmt, and ZEnlgmt values equally 

• To adjust the size of the symbol along the X axis, click on XEnlgmt. 
Use the value menu or type an enlargement factor, and press (Enter). 

• To adjust the size of the symbol along the Y axis, click on YEnlgmt. 
Use the value menu or type an enlargement factor, and press (Enter). 

• To adjust the size of the symbol along the Z axis, click on ZEnlgmt. 
Use the value menu or type an enlargement factor, and press (Enter). 

6. Rotate the symbol either dynamically positioning it or by setting a 
specific rotation angle for the symbol. The symbol is rotated around the 
insertion point, the point where the symbol is attached to your cursor.  

• To dynamically rotate the symbol into position when you place it in 
your drawing, toggle DynamRot on.  

• To set a specific rotation angle, toggle DynamRot off. Use the value 
menu or type an angle, and press (Enter). 

7. Cconvert the symbol into standard and separate lines and arcs when you 
place it in your drawing by toggling Explode on. 
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8. Place the symbol by clicking in the Drawing Area, using coordinate entry, 
or object snapping to a point in your drawing. The symbol is inserted into 
your drawing. For details on coordinate entry, see “Drawing Using 
Coordinate Entry” in “The Drawing Board” chapter. For details on object 
snapping, see “Object Snapping” in the “Drawing Tools” chapter. 

9. Repeat the previous step to continue placing the symbol in your drawing, 
or right-click to exit the menu. 

 To insert a symbol into your drawing using the Template menu: 

1. Right-click until the Utility menu is displayed in the Menu Window. 

2. Click on Template in the Utility menu. A dialog box is displayed. 

Shortcut: Press (T) anytime to open the Template menu. 

3. Locate the template you’d like to use and click on it to select it. The 
templates that come with DataCAD are in your DATACAD\TPL folder. 

4. Click on Open. The template is displayed on the right side of the Drawing 
Area, and the Template menu is displayed in the Menu Window. 

5. Rotate the symbol into position either dynamically or by setting a specific 
rotation angle. The symbol is rotated around the insertion point, the point 
where the symbol is attached to your cursor. 

• To dynamically rotate the symbol into position when you place it in 
your drawing, toggle DynamRot on.  

• To set a specific rotation angle, toggle DynamRot off. Use the value 
menu or type an angle, and press (Enter). 

6. Change the symbol size if necessary. Before you place a symbol in your 
drawing, you can increase or decrease the size of an entity by entering 
specific enlargement values for the X, Y, and Z axes: 

• To enlarge entities along the X axis, click on XEnlgmt. Use the value 
menu or type an enlargement factor, and press (Enter). 

• To enlarge entities along the Y axis, click on YEnlgmt. Use the value 
menu or type an enlargement factor, and press (Enter). 

• To enlarge entities along the Z axis, click on ZEnlgmt. Use the value 
menu or type an enlargement factor, and press (Enter). 

• To set the line spacing enlargement factor for non-solid linetypes, 
click on LineFact. Use the value menu or type a line factor, and press 
(Enter). The LineFact setting affects how linetypes like Dashed are 
enlarged. A setting matching those of the X, Y, and Z enlargement 
factors will maintain the linetype’s spacing. 

• To set all of these options to the same setting and enlarge the entity 
equally in all directions, click on SetAll. Use the value menu or type 
an enlargement factor, and press (Enter). 
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7. Decide if you need to place symbols above or below the current Z-base. 
When placing tree symbols on a 3D site plan for example, you can change 
the Z-Offset option to enter the trees at the proper elevation. To set the 
vertical distance above or below the correct Z-base where you’d like to 
insert your symbols, click on Z-Offset. Use the value menu or type an 
offset value, and press (Enter). Enter a positive value to place the symbol 
above the current Z-base; enter a negative value to place the symbol 
below the current Z-base. 

8. Decide if you want to change the symbol. Normally, symbols are placed 
in your drawing as a single entity, so DataCAD doesn’t recognize the 
individual lines and arcs that make up the symbol. To be able to edit a 
symbol in your drawing, you must explode (or convert) the symbol into 
separate lines and arcs. To convert the symbol into separate lines and arcs 
when you place it in your drawing, toggle Explode on. (Note that this will 
only explode those symbols entered into your drawing after Explode is 
toggled on. To explode symbols already in your drawing, you must use 
the SymExp macro, as described in the “Editing Symbols” section later in 
this chapter.) Exploded symbols appear the same as standard symbols, 
but DataCAD recognizes only the individual lines and arcs that make up 
the symbol, and not necessarily their relationship to each other. 

9. Select a symbol from the template by moving your cursor over the 
symbol you want to use and clicking. A box, representing the extents of 
the symbol, is attached to your cursor at the symbol’s insertion point. The 
symbol’s insertion point is marked by a small “x” once you place the 
symbol in your drawing. 

You can object snap to any point on a symbol to select an insertion point other 
than the one associated with the symbol definition. This is especially useful if you 
want to align a symbol with another entity in your drawing. Simply snap to the 
symbol in the template and then snap to the entity in your drawing to place the 
symbol. 

10. Place the symbol in your drawing by clicking in the Drawing Area, using 
coordinate entry, or object snapping to a point in your drawing. The 
symbol is inserted into your drawing.  

11. Repeat the previous step to continue placing the symbol in your drawing, 
or right-click to detach from the symbol. 

12. Open a different template if necessary by clicking on NewFile and 
selecting another template file from the dialog box. 

13. Close the template window by clicking on TemplOff. 

More About Templates and Symbols 
Each template is a graphic representation of the template (.TPL) file and is 
displayed with a number of divisions, each containing a symbol. The template 
file itself is a simple text file containing the name of the file, the number of rows 
and columns in the template, and the paths to the symbols associated with that 
template. When you select a template, the symbols associated with that template 
file are displayed in the template window. 
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Inserting Plumbing Symbols 
Not only can you insert plumbing symbols in your drawing, but you can also 
design lines of multiple plumbing fixtures and toilet partitions. The Furnitur and 
Mechanic options in the DCAD_AEC macro open a dialog box, allowing you to 
choose a template to display. 

 To insert a plumbing symbol: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in the Menu Window. If DCAD_AEC is not listed in 
the Macros pull-down menu, see “Customizing the Macros Menu” for 
details on how to add it to the menu. 

2. Click on Plumbing in the DCAD_AEC menu. The Plumbing menu is 
displayed in the Menu Window. You are prompted to “Enter first point 
along fixture wall”. 

3. Define the wall where you will place plumbing fixtures. To enter one end 
point of the wall your plumbing fixtures will be drawn along, click in the 
Drawing Area, use coordinate entry, or object snap to a point in your 
drawing. You are prompted to “Enter second point along fixture wall”. 

4. Enter the other end point of the wall by clicking in the Drawing Area, 
using coordinate entry, or object snapping to a point in your drawing. 
You are prompted to “Point to side of wall on which to add fixtures”. 

5. Click on the side of the wall where the plumbing fixtures will be drawn. 
Several fixture options are displayed in the Menu Window. 

6. Add fixtures such as handicapped stalls, standard stalls, urinals, and 
sinks to your drawing. Click on PlumbSym to display the standard 
template dialog box and insert plumbing symbols using the Template 
menu, as described earlier in this chapter. To determine the number of 
each, click on the “+” and “-“ buttons under the HC Stall, Stall, Urinal, 
and Sink headings. The total number of each fixture, along with the 
available space left along the wall, is displayed in the Message Area. You 
can only add a fixture if available space allows. 

7. Customize the dimensions and location of each type of fixture: 

• To customize handicapped stalls, click on HC Stall. The HC Stall 
menu is displayed in the Menu Window. Use the options, as 
described in “Handicapped Stall Options” below, to customize 
handicapped stall fixtures. 

• To customize standard stalls, click on Stall. The Stall menu is 
displayed in the Menu Window. Use the options, as described in 
“Standard Stall Options” below, to customize stall fixtures. 

• To customize urinals, click on Urinal. The Urinal menu is displayed in 
the Menu Window. Use the options, as described in “Urinal Options” 
below, to customize urinal fixtures. 



|  CHAPTER 16: SYMBOLS, IMAGES, AND OBJECTS  344

• To customize sinks, click on Sink. The Sink menu is displayed in the 
Menu Window. Use the options, as described in “Sink Options” 
below, to customize sink fixtures. 

8. Draw the plumbing fixtures according to the Plumbing menu options 
you’ve set by clicking on Begin. The fixtures are drawn, beginning from 
the second wall end point you entered. Handicapped stalls are always 
drawn first, followed by standard stalls, urinals, and finally sinks. You 
can’t customize the order in which fixtures are drawn. 

Handicapped Stall Options 
DataCAD’s toilet symbols are in your DATACAD\SYM\ TOILETS folder. 
Number Set the number of stalls to draw (use the value menu to set the number or click on 

+HC Stl and -HC Stl in the Plumbing menu). For more information on using value 
menus, see “Value Menus” in “The Drawing Board” chapter. 

Length Set the length of the stall; the length is measured from the wall behind the fixture to 
the inside of the partition containing the stall door 

Width Set the width of the stall; the width is measured from the inside of one partition wall 
to the inside of the other 

OpgWidth Set the width of the stall opening; if a door is drawn, this option also sets the width of 
the door 

Doors Toggle on to draw doors on stalls; toggle off to draw stalls without doors 
 
The HingeRt and SwingIn options are only available if Doors is toggled on. 

HingeRt Toggle on to draw doors hinged on the right side of stalls (as you face the stall); 
toggle off to draw doors hinged on the left side of stalls 

SwingIn Toggle on to draw doors that swing into stalls; toggle off to draw doors that swing 
out from stalls 

ToiltSym Open dialog box and select a custom toilet symbol to use when drawing handicapped 
stalls 

ResetDef Reset all HC Stall menu settings to their defaults 

Standard Stall Options 
DataCAD’s toilet symbols are in your DATACAD\SYM\ TOILETS folder. 
Number Set the number of stalls to draw (use the value menu to set the number or click on 

+Stall and -Stall in the Plumbing menu). For more information on using value menus, 
see “Value Menus” in “The Drawing Board” chapter. 

Length Set the length of the stall; the length is measured from the wall behind the fixture to 
the inside of the partition containing the stall door 

Width Set the width of the stall; the width is measured from the inside of one partition wall 
to the inside of the other 

OpgWidth Set the width of the stall opening; if a door is drawn, this option also sets the width of 
the door 

Doors Toggle on to draw doors on stalls; toggle off to draw stalls without doors 
 
The HingeRt and SwingIn options are only available if Doors is toggled on. 

HingeRt Toggle on to draw doors hinged on the right side of stalls (as you face the stall); 
toggle off to draw doors hinged on the left side of stalls 

SwingIn Toggle on to draw doors that swing into stalls; toggle off to draw doors that swing 
out from stalls 

ToiltSym Open dialog box and select a custom toilet symbol to use when drawing stalls 
ResetDef Reset all Stall menu settings to their defaults  
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Urinal Options 
Number Set the number of urinals to draw (use the value menu to set the number or click on 

+Urinal and -Urinal in the Plumbing menu). For more information on using value 
menus, see “Value Menus” in “The Drawing Board” chapter. 

Spacing Set the distance between urinal partitions; if partitions are not drawn, the distance is 
measured from the center of one urinal to the center of the next 

Partitn Toggle on to draw partitions between urinals; toggle off to draw urinals without 
partitions (a partition is always drawn between the last urinal and the first sink) 

PrtnSize Set the length of partitions; the length is measured from the wall out to the edge of the 
partition; PrtnSize is only available when the Partitn option is toggled on 

UrnlSym Open dialog box and select a custom urinal symbol to use when drawing urinals. 
DataCAD’s urinal symbols are in your DATACAD\SYM\ TOILETS folder. 

ResetDef Reset all Urinal menu settings to their defaults  

Sink Options 
Number Set the number of sinks to draw (use the value menu to set the number or click on 

+Sink and -Sink in the Plumbing menu) 
Spacing Set the distance from the center of one sink to the center of the next; only available if 

FitSinks is toggled off. Because the FitSinks option uses all remaining space on the 
fixture wall, the Space Left display in the Message Area always reads 0 when FitSinks 
is toggled on, no matter how many sinks are added or subtracted. 

FitSinks Toggle on to override the Spacing setting and automatically calculate the spacing 
between sinks; you can add sinks until they butt up against one another but this 
option will not allow them to overlap; toggle off to use the Spacing setting 

CodeMin Toggle on to set a minimum distance of 1’-6” between the center of the last sink and 
inner edge of the wall; toggle off to automatically set this to half the center-to-center 
sink spacing 

SinkSym Open dialog box and select a custom sink symbol to use when drawing sinks. 
DataCAD’s sink symbols are in your DATACAD\SYM\ SINKS folder. 

ResetDef Reset all Sink menu settings to their defaults 

Drawing Electrical Symbols and Ceiling Grids 
Along with inserting electrical symbols in your drawing, you can also create 
ceiling grids of any size and orientation. 

 To insert electrical symbols: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in the Menu Window. If DCAD_AEC is not listed in 
the Macros pull-down menu, see “Customizing the Macros Menu” for 
details on how to add it to the menu. 

2. Click on Electric in the DCAD_AEC menu. The Electric menu is displayed 
in the Menu Window.  

3. Click on ElecSymb in the Electric menu. If no template is currently being 
displayed, a dialog box is displayed. 

4. Continue with step 3 of the instructions on inserting a symbol using the 
Template menu on page 341. 

 To create a ceiling grid: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in the Menu Window. 
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2. Click on Electric in the DCAD_AEC menu. The Electric menu is displayed 
in the Menu Window.  

3. Click on CeilGrid in the Electric menu. The CeilGrid menu is displayed. 
You can also use the CeilGrid menu to draw a floor grid that you can 
place furniture symbols on. Be sure to toggle Z-base on in the CeilGrid 
menu. 

4. Draw the ceiling grid at either Z-base or Z-height. To draw the ceiling 
grid at the current Z-base, toggle Z-Base on in the CeilGrid menu. To 
draw the grid at the current Z-height, toggle Z-Hite on. 

5. Define a boundary for the ceiling grid. Click on Boundary to display the 
Boundary menu in the Menu Window. 

6. Use any 3D polygon as a boundary for your grid. If you already have a 
3D polygon in your drawing that you can use for the boundary, you can 
select it; if you don't, you can create a boundary for your ceiling grid. 

• To use a 3D polygon already in your drawing, click on Select. A 
selection menu is displayed, and you are prompted to select a ceiling 
boundary. Choose a selection method from the selection menu, and 
then select the 3D polygon you want to use for your boundary. Skip 
to step 10. For more information on using selection menus, see 
“Selection Menus” in “The Drawing Board” chapter. 

• To create a boundary for your grid, click on Create. The Create menu 
is displayed in the Menu Window. You are prompted to "Enter the 
first corner of the ceiling boundary". 

7. Click in the Drawing Area, use coordinate entry, or object snap to an 
entity in your drawing to select the first point for the boundary. You are 
prompted to "Enter the next corner of the ceiling boundary". You can add 
your boundary to a specific selection set as well as set the color, linetype, 
line width, and line spacing of the boundary line. For more information 
about boundary settings, see Boundary Menu Settings on the following 
pages. 

8. Click in the Drawing Area, use coordinate entry, or object snap to an 
entity in your drawing to select the next point on the boundary.  

9. Repeat the previous step until your boundary is complete. You can click 
Backup any time to erase the last line segment or arc of your boundary. 
You can click Cancel at any time to erase the boundary you’re drawing. 

10. Right-click or click on Close in the Create menu to finish your boundary. 
You are returned to the Boundary menu. 

11. Right-click to exit the Boundary menu and return to the CeilGrid menu. 

12. Click on Grids to display the Grids menu. For more information about 
grid settings, see “Grids Menu Settings” on the following pages. 

13. Set the distance between grid lines in the X direction by clicking on X-Size 
in the Grids menu. A value menu is displayed. 

14. Use the value menu or type a distance, and press (Enter). 
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15. Set the distance between grid lines in the Y direction by clicking on Y-Size 
in the Grids menu. A value menu is displayed. 

16. Use the value menu or type a distance, and press (Enter). 

17. Rotate the grid by clicking on RotAngle in the Grids menu. A value menu 
is displayed. 

18. Use the value menu or type an angle, and press (Enter). 

19. Notice if you've selected a polygon for your boundary and you want to 
trace over the polygon to graphically show the boundary, toggle 
DoBound on in the Grids menu to display the grid boundary when you 
draw the grid. If you created a boundary in step 6, toggle DoBound off. 

You can add your grid to a specific selection set as well as set the color, linetype, 
line width, and line spacing of the grid lines. 

20. Draw the grid by entering a point in the Drawing Area where you want 
the grid to start. Click in the Drawing Area, use coordinate entry, or 
object snap to an entity in your drawing to enter the grid starting point. 
The grid is drawn within the boundary. You can enter the starting point 
anywhere in the Drawing Area, but the grid will actually be drawn only 
within the boundary you defined earlier. 

21. Right-click to exit the Grids menu and return to the CeilGrid menu. 

22. Add lighting fixtures to your ceiling grid. Click on Fixtures in the 
CeilGrid menu to display the Fixtures menu. For more information about 
fixture settings, see “Fixtures Menu Settings” on the following pages. 

23. Use a symbol for the lighting fixtures by toggling UseSymb on; to use a 
polygon to represent the fixtures, toggle UsePoly on. (A different set of 
options will be available, depending on which option you toggle on.) 

24. Define the symbol or polygon to be used for your fixtures. Of the two 
options, UseSymb and UsePoly, only one can be toggled on at any given 
time. 

• If you toggled UseSymb on, click on SymbNam in the Fixtures menu. 
A dialog box is displayed, and you are prompted to "Enter file name 
of symbol to use". Select a symbol to use for the lighting fixtures, and 
click on Open. 

• If you toggled UsePoly on, click on PolySize. A list of rectangular 
sizes followed by a list of circular sizes are displayed in the Menu 
Window. Click on a size for the polygon, and then right-click to 
return to the Fixtures menu. Use the CustRect option to define a 
custom-sized rectangle, or use the Cust Rnd option to define a custom 
circular polygon. 

25. Enter the fixtures at an angle in your grid by clicking on RotAngle and 
using the value menu to enter a rotation angle. 

26. Toggle Cutout on to automatically erase the grid lines that would 
otherwise run through the middle of the fixture symbol or polygon. 
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27. Enter each fixture by its corner by toggling ByCornr on; to enter each 
fixture by its center, toggle ByCentr on. 

28. Notice that a circle or rectangle representing the fixture is now attached to 
your cursor. Click in the Drawing Area, use coordinate entry, or object 
snap to a point on your grid to draw a fixture. 

29. Repeat the previous step to enter additional fixtures on your ceiling grid. 

Click on Cleanup in the CeilGrid menu to use the Cleanup menu without exiting 
the DCAD_AEC macro. 

Boundary Menu Settings 
Select Select an existing boundary or any 3D polygon to act as a boundary for your ceiling 

grid 
Create Draw a boundary for the ceiling grid; enter up to 36 sides in a single boundary 
Delete Delete any existing boundaries or 3D polygons 
Sel Set Choose the selection set to add a boundary to; only the first boundary added to a 

selection set can have a grid drawn in it 
ShwBoun Displays the number of polygons in that selection set 
Clear SS Delete all boundaries from that selection set. The ClearSS option doesn't delete the 

actual polygons from your drawing; rather this option simply disassociates the 
polygons from the selection set.  

Color Set the color of boundaries  
LineType Set the linetype of boundaries 
LineWdth Set the width of boundary lines. For more information on using value menus, see 

“Value Menus” in “The Drawing Board” chapter. 
LinSpcng Set the spacing of boundary lines (only affects linetypes with spaces in them, such as 

Dashed) 

Grids Menu Settings 
X-Size Set the distance between grid lines in the X direction 
Y-Size Set the distance between grid lines in the Y direction 
RotAngle Set the rotation angle of the grid 
DoBound Toggle on to draw the grid boundary when you draw the grid 
Grid SS Set the selection set to add the grid to 
ShowGrid Display the number of lines in the current selection set in the Message Area 
Append Toggle on to add multiple grids to the same selection set; toggle off to replace the 

previous grid drawn in the current selection set with a new grid. If Append is toggled 
off and you insert lighting fixtures into overlapping grids, only the last grid drawn 
will be affected by such settings as Cutout. 

Color Set the color of grids. For more information on using color menus, see “Color Menus” 
in “The Drawing Board” chapter. 

LineType Set the linetype of grids 
LineWdth Set the width of grid lines. For more information on using value menus, see “Value 

Menus” in “The Drawing Board” chapter. 
LinSpcng Set the spacing of grid lines (only affects linetypes with spaces in them, such as 

Dashed) 

Fixtures Menu Settings 
UseSymb Toggle on to use a symbol to represent fixtures 
UsePoly Toggle on to use a polygon for fixtures 
SymbName Choose the symbol to use for fixtures; available only when UseSymb is toggled on 
PolySize Choose a rectangular or round polygon to represent fixtures; available only when 

UsePoly is toggled on 
RotAngle Set the rotation angle for fixtures 
Cutout Toggle on to cut the ceiling grid and erase grid lines that would otherwise display 

over the fixture 
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ByCornr Toggle on to insert fixtures by their corners 
ByCentr Toggle on to insert fixtures by their centers 
Grid SS Set the selection set to add the grid to 
ShowGrid Display the number of lines in the current selection set in the Message Area 
ObjSnap Shortcut to the ObjSnap menu. For more information on object snapping, see “Object 

Snapping” in the “Drawing Tools” chapter. 
Color Set the color of fixtures 
LineType Set the linetype of fixtures 
LineWdth Set the width of fixture lines 
LinSpcng Set the spacing of fixture lines (only affects linetypes with spaces in them, such as 

Dashed) 

Inserting Stamps 
You can choose from more than a dozen pre-formatted date-, time-, and file-
related stamps to insert into your drawing. The examples shown in the stamp 
selection menu are based on the current date, time, and file settings as they will 
appear in the drawing. The values are updated when the display is regenerated 
and when the drawing is printed. Since a stamp is really an ordinary DataCAD 
text entity that contains a special formatting string, it has all the font, sizing, and 
style options of ordinary DataCAD text strings. You can further customize how 
you want stamps to appear in your drawing by doing a change/text/content and 
adding text around the special strings. Stamp text can be used in XREFs and 
symbols. The values update automatically, making stamps very flexible. 

 To add a stamp to your drawing: 

1. Select Stamp form the Insert pull-down menu. 

2. Select the stamp you want to use from the extended menu. 

Inserting o2c Objects 
Thousands of o2c objects -- including people, cars, furniture, and landscape 
elements -- are available for you to import into DataCAD drawings. Or you can 
import your own o2c objects, such as your company logo. 

 To insert an o2c object: 

1. Click on o2c Object in the Insert pull-down menu. A dialog box is 
displayed, prompting you to “Select o2c file to import”. 

2. Locate the o2c object you want to insert into your drawing, and click on it 
to select it. 

3. Click on Open. The dialog box closes, and a box representing the extents 
of the o2c object is now attached to your cursor. 

4. Place the object by clicking in the Drawing Area, using coordinate entry, 
or object snapping to a point in your drawing. The o2c object is inserted 
into your drawing. For details on coordinate entry, see “Drawing Using 
Coordinate Entry” in “The Drawing Board” chapter. For details on object 
snapping, see “Object Snapping” in the “Drawing Tools” chapter. 

5. Repeat the previous step to continue placing the object in your drawing, 
or right-click to exit the menu. 
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Importing BMP and JPEG Images 
You can import both bitmap (.BMP) and JPEG (.JPG) files into your DataCAD 
drawing. Import any number of black and white, grayscale, and 8- to 32-bit color 
images. You can trace scanned drawings, display site maps, or show digital 
photos of existing building facades when you import bitmaps into your drawing. 

Imported bitmaps are referenced, not inserted into your drawing file. That means 
your drawing file size will not increase. 

 To import an image: 

1. Click on Bitmap in the Insert pull-down menu. The Select Image dialog 
box is displayed. 

3. Click on the .BMP or .JPG file you want to insert in your drawing and 
click Open. The Bitmap menu is displayed in the Menu Window, and you 
are prompted to “Enter first point of bitmap rectangle”. 

4. Toggle OutLine on if you want to draw a visible polyline boundary 
around the inserted image. Toggle NoOutLin on if you do not want a 
visible boundary around the image. These are mutually exclusive toggles. 

5. Toggle the FixRatio option on to preserve the original dimensions of the 
image; toggle it off to dynamically stretch the X and/or Y ratios while 
you are inserting the bitmap. After you insert the image, you cannot 
change the ratio if FixRatio was turned on; therefore, for future flexibility, 
you may want to turn FixRation off. 

While working in your drawing, you can toggle off Bmp On in the Display 
menu to decrease drawing refresh times by not displaying all the bitmaps 
in your drawing. Toggle it on again to display all images in your drawing 
as well as allow printing of them. Notice that SWOTHLUDFB in the 
Status Window contains an upper-case letter B if BmpOn is active; but it 
turns to a lower-case b if BmpOn is not active. 

4. Enter the first corner of the image’s extents by clicking in the Drawing 
Area, using coordinate entry, or object snapping to an existing point in 
your drawing. Notice that if you move your cursor diagonally away from 
that point, a rectangular box (representing the extents of your image) 
stretches with it. You are prompted to “Enter second point of bitmap 
rectangle”.  

6. Enter the corner diagonal from the first corner by clicking in the Drawing 
Area, using coordinate entry, or object snapping to an existing point in 
your drawing. The image is inserted in your drawing. If Bmp On is 
toggled off in the Utility/Display menu, only a rectangular box 
representing the extents of the image is displayed in your drawing. To 
display your image, toggle Bmp On in the Display menu. 

7. Use the Calibrate options in the Enlarge menu to scale bitmaps to real-
world size. For more information about this, see “Calibrating 
Enlargements” in this chapter. 
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You can control whether bitmaps or JPEGs print behind or in front of lines by 
using the Print first or Print last options in the Pen Table. For more information 
about using the Pen Table, see “Using Pen Tables” in the “Printing Your 
Drawing” chapter. 

Calibrating Enlargements 
You can enlarge or reduce imported bitmap and vector graphics to real-world 
scale. For example, if you import a site map, you can use the Calibrate Distance 
function to enlarge the plan to real-world dimensions. 

 To calibrate imported bitmaps or vector graphics and enlarge to real-world 
size: 

1. Select Enlarge from the Edit menu. You are prompted to “Select CENTER 
of enlargement.” 

2. Click on the graphic you want to resize. Options appear in the Enlarge 
menu. 

3. Select Enlrgmnt to display the calibration options. 

4. Click on CalDist.  

5. Show the length of an entity or a known distance in the bitmap by 
clicking on your imported graphic at the first point to begin drawing a 
measuring line. Extend the line and click again when you reach the end of 
the entity or known distance in the graphic. You are prompted to “Enter 
new distance.” The current distance follows this prompt.  

6. Replace that value with what it should be in the “real world.” For 
example, the current value may be 0.8, but in reality, it should be 6 feet; 
therefore, you would type 6 in the input field. Press (Enter).  DataCAD 
calculates the enlargement factor and displays it in the Message Window. 

7. Select the entity or entities that you want to enlarge by that factor. 

CalDist automatically calculates an equal X/Y enlargement factor. Instead of 
CalDist, you can use the CalX-Y, CalX, or CalY options to enlarge entities 
independently or unequally in the X and Y directions. 

Drawing Arrows 
You can draw arrows of varying widths using the Arrow macro. 

 To draw an arrow: 

1. Click on Arrow in the Macros pull-down menu. The Arrow menu is 
displayed in the Menu Window. If ARROW is not listed in the Macros 
pull-down menu, see “Customizing the Macros Menu” for details on how 
to add it to the menu. 

2. Click on Width in the Arrow menu. A value menu is displayed. 

3. Use the value menu or type a width for the arrow, and press (Enter). You 
are prompted to "Enter first point of arrow centerline". 
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4. Enter the two end points of the arrow. Click in the Drawing Area, use 
coordinate entry, or object snap to an entity to enter the base of the arrow. 
Notice that the length and direction of the arrow changes as you move 
your cursor. You are prompted to "Enter second point of arrow 
centerline". 

5. Click in the Drawing Area, use coordinate entry, or object snap to an 
entity to enter the tip of the arrowhead. The arrow is drawn. 

Creating and Editing Templates 
Templates are a very effective way to organize a library of predrawn items, 
which you can use in many different projects. You can, for instance, create a 
template with symbols that you use frequently or one that supports office 
standards. See “More About Creating Templates” for details on defining 
information fields. 

Each template has information fields defined specifically for that template. 
Whenever you add a symbol to that template, you can enter information 
describing that symbol in each field.  There are six standard information fields 
that are defined for every template, but you can define an unlimited number of 
additional fields. 

 To create a template: 

1. Click on Template in the Utility menu; or if you’re already in the 
Template menu, click on NewFile. A dialog box is displayed. 

2. Type a name for your new template, and click on Open or press (Enter). 
The dialog box closes, and you are prompted with “Create new file?” For 
more information about establishing a naming system for template files, 
see “More About Naming Templates” later in this chapter. 

Toggle AutoPath on in the Template menu to automatically create a 
folder in your SYM\ folder with the same name as the template file 
you’re creating. This allows you to easily keep track of the symbols 
associated with your new template. 

3. Click on Yes in the Menu Window to create the template. You are 
prompted with “Field name”. 

4. Notice that all templates have six standard fields automatically defined 
for them. You can either define additional information fields, or simply 
create the template with only the standard six fields. To use only the 
standard fields, right-click and skip to step 7. To enter an additional field, 
type a name for the field (up to 20 characters) and press (Enter). A list of 
field data types is displayed in the Menu Window, and you are prompted 
to “Select field type”. 
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5. Notice that there are three field types available: text, number, and dollar. 
To create a field that you can enter letters and numbers into, click on Text. 
To create a field that you can enter an integer into, click on Number. To 
create a field that you can enter a real number with two fixed decimal 
places, click on Dollar. Numbers entered in a text field cannot be used in 
any calculations. 

6. Repeat steps 4 – 5 to continue entering information fields.  

7. Right-click when you’ve completed entering fields. The template is 
created and displayed at the right side of the DataCAD window, and the 
Template menu is displayed in the Menu Window. For information on 
how to add symbols to your new template, see “Creating Symbols later in 
this chapter. 

More About Creating Templates 
When you create a template, DataCAD automatically defines six information 
fields: 
Field Name Field Type 
Item nam Text 
Manufact Text 
Model No Text 
Remark 1 Text 
Remark 2 Text 
Cost Dollar 

 
You can create an unlimited number of additional information fields when you 
create a template. This is the only time you can define information fields; once the 
template is created, you can’t add another field or delete a field, nor can you 
change the field’s name or type.  

While you can’t change the fields themselves, you can always edit any 
information you’ve entered into a field. See “Editing Information Fields” later in 
this chapter for more information. All fields you create can accept up to 80 
characters of information.  

More About Naming Templates 
As you add more and more templates to your library, it becomes increasingly 
important to name those templates in an organized, easily recognizable way. You 
can simply give your templates longer, more descriptive names, such as “office 
chairs.tpl” or “living room.tpl”.  Template names with spaces or more than 8 
characters may not be compatible with older versions of DataCAD.  The total 
name including path cannot exceed 80 characters. Or you can devise a naming 
system like the following one: 

• Sweet’s catalog section number 

• title of template 

• chronological number of template 
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For example, if you’re creating a template of door jamb details, and three similar 
templates already exist, you could name this fourth template 08JAMB04.TPL: 
“08” is the catalog number, “JAMB” is the title of the template, and “04” tells you 
it’s the fourth template of door jambs. 

Editing Templates 
Templates you create in DataCAD have a standard number of divisions: three 
columns and 12 rows. Once you’ve created a template, you can change the 
number of divisions to suit your needs. For information on editing the symbols 
in a template, see “Editing Symbols” later in this chapter. 

The number of divisions in a template doesn’t have to equal the number of 
symbols associated with that template. You can have more divisions than 
symbols, in which case some of the divisions in your template will be empty. 
You can also have fewer divisions than symbols, so that not all symbols 
associated with that template will be displayed at once. Displaying fewer 
symbols will also increase refresh times. 

 To change the number of divisions in a template: 

1. Create your template. Then click on Divisons in the Template menu. You 
are prompted with “Number of X-divisions in template”. 

2. Use the value menu or type the number of columns for your template, 
and press (Enter). You are prompted with “Number of Y-divisions in 
template”. 

3. Use the value menu or type the number of rows for your template, and 
press (Enter). The template is updated with the new divisions, and you 
are returned to the Template menu. 

Creating and Editing Symbols 
Creating and editing symbols is a very effective way to build a library of 
predrawn items that you can use in many different projects. You can, for 
instance, draw a lighting fixture, create a symbol from the fixture geometry and 
add it to a template, and then very quickly place several instances of that fixture 
in your drawing.  

To quickly determine the exact path and folder name of a symbol, click on 
SymName in the Template menu and then click on the symbol. 

You can also enter descriptive information about each symbol, and then edit that 
information. You can even replace symbols in your drawing with others in your 
symbol library. 

 To create a symbol and add it to a template: 

1. Click on Template in the Utility menu. The Template menu is displayed 
in the Menu Window. 

Shortcut: Press (T) to display the Template menu. 
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2. Click on SaveSymb. A dialog box is displayed, prompting you to “Enter 
name of symbol file to be saved. Symbol folders are stored in your 
DATACAD\SYM folder. 

3. Make sure the folder that’s open in the dialog box is the one you want to 
save the symbol in. If it’s not, change to the proper folder. 

4. Type a name for your symbol and click on Save. The SaveSymb menu is 
displayed in the Menu Window. Use SaveSymb to select either symbols 
already in your drawing or geometry you want to make into a symbol;  
both types of selection will be added to the currently displayed template. 

5. Choose a selection method and then select the parts of your drawing you 
want to make into a symbol. You are prompted to “Select reference point 
for symbol”. 

6. Select the reference, or insertion. You can point for the symbol, click in 
the Drawing Area, use coordinate entry, or object snap to a point in your 
drawing. The entities you selected are copied into the first open space in 
the template; if there are no open spaces in the currently displayed 
template, the symbol can’t be displayed in that template until you 
increase the number of template divisions. The first field, called Item 
Name, is displayed in the Message Area. 

7. Enter a name for your symbol. You are prompted to enter information for 
additional fields. 

8. Continue to enter symbol information for each field, or press (Enter) to 
skip a field and continue with the next. To skip all remaining fields, right-
click. The dialog box is displayed again. 

9. Continue with step 3 above to save additional symbols. 

More About Naming Symbols 
As you add more and more symbols to your templates, it becomes increasingly 
important to name those symbols in an organized, easily recognizable way. You 
can simply give your symbols longer, more descriptive names, such as “office 
chair.sym” or “kitchen sink.sym”. Or you can devise a naming system like the 
following one: 

• Sweet’s catalog section number 

• title of symbol 

• chronological number of symbol 

For example, if you’re creating a door jamb symbol, and two similar symbols 
already exist, you could name this third symbol 08JAMB03.SM3: “08” is the 
catalog number, “JAMB” is the title of the symbol, and “03” tells you it’s the 
third door jamb symbol. Symbol names with spaces or more than 8 characters 
may not be compatible with older versions of DataCAD.  The total name 
including path cannot exceed 80 characters. 



|  CHAPTER 16: SYMBOLS, IMAGES, AND OBJECTS  356

Editing Symbols 
To edit symbols, you must first explode, or convert, them into individual lines and 
arcs. You can do this when you insert the symbol into your drawing or after the 
symbol has been inserted. Once the symbol has been edited, you can reform the 
symbol lines and arcs into a single symbol entity and copy it back into the 
template and then update the symbols already in your drawing. 

 To explode a symbol when you place it in your drawing and edit it: 

1. Click on Template in the Utility menu. A dialog box is displayed, 
allowing you to choose a template to open.  

2. Click on the template you want to use, and click on Open. The template is 
displayed on the right side of the Drawing Area, and the Template menu 
is displayed in the Menu Window. 

3. Toggle Explode on in the Template menu. 

4. Click on the symbol in the template that you want to insert into your 
drawing. 

5. Place the symbol in your drawing. You can click in the Drawing Area, use 
coordinate entry, or object snap to an entity in your drawing. The symbol 
is copied to your drawing and automatically exploded into separate 
entities. 

6. Edit the symbol geometry as necessary. For more information on editing 
lines and arcs, see the “Editing Drawings” chapter. 

7. Copy your changes back to the template. Click on Redefine in the 
Template menu. You are prompted to “Point to symbol in template 
window to redefine”.  

8. Click on the symbol in the template that you just edited in the Drawing 
Area. A selection menu is displayed, and you are prompted to select the 
geometry you want to be your new symbol. 

9. Choose a selection method, and then select the geometry for the symbol. 
Your selection is highlighted with dashed lines. If necessary, continue 
selecting geometry until all entities that you want to be included in the 
new symbol are highlighted. 

10. Click on Continue to go on with the symbol definition process. You are 
prompted to “Select a reference point for symbol”. 

11. Click in the Drawing Area or use coordinate entry to select the point that 
will be used to insert the symbols in drawings. The edits to the symbol 
are copied to the template. 

12. Update all instances of that symbol in your drawing. Click on Re-Load in 
the Template menu. You are prompted to “Point to symbol in template 
window to re-load from disk”. 

13. Click on the symbol in the template that you want to reload, or click on 
All in the Re-Load menu to reload all symbols in your drawing. 
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 To explode a symbol already in your drawing and edit it: 

1. Click on SymExp in the Macros pull-down menu. A selection menu is 
displayed in the Menu Window. If SYMEXP is not listed in your Macros 
menu, click Configure in the Macros menu and add SYMEXP to the 
Macros in Menu list. 

2. Choose a selection method, and then select the symbol(s) you want to 
edit. The number of symbols selected and the number of entities they 
were exploded into is displayed in the Message Area. For more 
information on using selection menus, see “Selection Menus” in “The 
Drawing Board” chapter. 

3. Edit the symbol geometry as necessary. 

4. Load your changes to this symbol back into its template if necessary. 
Then, open the appropriate template and continue with step 7 in the 
previous instructions. 

Editing Information Fields 
You can edit information associated with symbols by selecting a symbol in a 
template or one that’s already in your drawing. Use the Reports option in the 
Template menu to extract symbol information for all symbols used in your 
drawing, and create specification reports or cost estimates. See the “Reports and 
Estimates” chapter for more information. 

 To edit symbol information: 

1. Open the template that the symbol (whose information you want to edit) 
is associated with.  

2. Click on EditFlds in the Template menu. 

3. Click on the symbol, either in the template or in your drawing, whose 
information you want to edit. The fields for that symbol are displayed in 
the Menu Window. 

4. Click on the field you want to edit. 

5. Type the new information for that field and press (Enter). 

6. Repeat steps 4 –5 to continue changing field information as necessary. 

7. Edit information for another symbol by right-clicking and continuing 
with step 3 above. Right-click twice to exit back to the Template menu.  

 To edit symbol information: 

1. Click on FormAtr in the Macros pull-down menu. The FormAtr menu is 
displayed in the Menu Window. If FormAtr is not listed in your Macros 
menu, click Configure in the Macros menu and add it to the Macros in 
Menu list. 

2. Click on Symbol in the FormAtr menu. You are prompted to “Select 
symbol to edit attribute fields”. 
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3. Click on the symbol. The symbol’s information is displayed in the 
Drawing Area. 

4. Press (Tab) to move the edit box to the text you want to change.  

5. Type the new text and press (Enter). The information is changed. 

6. Repeat steps 4 – 5 to continue editing. 

7. Press (Esc) to exit editing and return to your drawing. You are prompted 
with “Do you wish to update symbol file [symbol path and filename]?” 

8. Click on Yes to update the symbol information; click on No to cancel the 
changes. 

Replacing Symbols in Your Drawing 
You can replace one symbol in your drawing with another and choose whether 
to replace one instance of that symbol or all instances throughout your drawing. 
This is useful, for instance, if you’ve entered one type of bathroom sink 
throughout your drawing and you need to replace it with another type. 

 To replace one symbol with another symbol: 

1. Click on Template in the Utility menu. The Template menu is displayed 
in the Menu Window. 

2. Click on Replace in the Template menu. The Replace menu is displayed 
in the Menu Window, and you are prompted to “Point to the symbol to 
replace”. 

3. Click on the symbol in your drawing that you want to replace. You are 
prompted to “Point to symbol to replace with”. 

4. Choose the new symbol that will replace the original by clicking on a 
symbol in a template or on one that’s already in your drawing. A 
selection menu is displayed in the Menu Window. 

5. Replace only particular instances of the symbol you selected in step 3 or  
replace all instances of that symbol. To choose particular instances of the 
symbol, choose a selection method from the menu, and continue with the 
next step. To replace all instances of the symbol, click on All; all instances 
of the symbol are immediately replaced, and you can skip to step 7. 

6. Select each instance of the symbol that you want to replace. Each symbol 
is replaced as you select it.  

7. Finish replacing symbols. Then, right-click to return to the Template 
menu. 

 To replace several different symbols with another symbol: 

1. Click on Template in the Utility menu. The Template menu is displayed 
in the Menu Window. 

2. Click on Replace in the Template menu. The Replace menu is displayed 
in the Menu Window, and you are prompted to “Point to the symbol to 
replace”. 
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3. Click on AnySymb in the Replace menu. You are prompted to “Point to 
symbol to replace with”. 

4. Choose the new symbol that will replace the original by clicking on a 
symbol in a template or on one that’s already in your drawing. A 
selection menu is displayed in the Menu Window. 

5. Select each symbol you want to replace or replace every symbol in your 
drawing. To choose each symbol, choose a selection method from the 
menu, and continue with the next step. To replace all symbols, click on 
All; all symbols in your drawing are immediately replaced. 

6. Select the symbols to be replaced. Each symbol is replaced as you select it.  

7. Finish replacing symbols. Then, right-click to exit the Replace menu and 
return to the Template menu. 

Deleting Symbols 
You can erase symbols from your drawing or delete them from a template.  

 To erase a symbol: 

1. Click on Erase in the Edit menu. The Erase menu is displayed in the 
Menu Window. 

2. Toggle LyrSrch on if the symbols you want to erase are on a layer other 
than the active layer. 

3. Click on a selection method in the menu. You are prompted to select the 
entities you want to erase. 

4. Select the symbols; they are erased from the drawing. You can continue 
selecting symbols to erase them. Avoid selecting a symbol where it 
crosses another entity, because it may be difficult for DataCAD to know 
which entity you want to select. Zoom in on your drawing or change 
your view to select symbols more precisely. 

5. Finish erasing symbols. Then, right-click to exit the Erase menu. 

 To delete a symbol from a template: 

1. Click on Template in the Utility menu. A dialog box is displayed, 
allowing you to choose a template to open.  

2. Click on the template with the symbol you want to delete, and click on 
Open. The template is displayed on the right side of the Drawing Area, 
and the Template menu is displayed in the Menu Window. 

3. Click on DelSymb in the Template menu. You are prompted to “Select 
symbol to delete from this template file”. 

4. Click on the symbol you want to delete from the template. You are asked 
to confirm your selection. 

5. Click on Yes to delete the symbol; click on No to cancel the function. 
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6. Continue selecting symbols to delete them from the template, or right-
click to exit the DelSymb menu.  

More About Erasing Symbols 
When you erase symbols from your drawing, it’s important to purge the symbol 
from your drawing as well. When you add a symbol to your drawing, DataCAD 
associates that symbol with your drawing. This association is not deleted when 
you erase the symbol and continues to take up drawing file space. To delete the 
association as well, you must use the PurgeSym option in the Template menu. 

 To purge symbol associations from your drawing: 

1. Click on PurgeSym in the Template menu. You are prompted with “Are 
you sure you want to purge unused symbols?” 

2. Click on Yes to purge the associations with symbols that have been 
deleted; click on No to cancel the function. 
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